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AUDIENCE

This book is intended for new users of Meeting Maker Calendar. This 
book contains information on installing, launching, configuring, and 
signing into Meeting Maker Calendar and HTML Calendar. It also 
contains introductory information on using Meeting Maker Calendar.

RELATED DOCUMENTATION

• Meeting Maker Installation Guide

• Meeting Maker Administation Guide

• Meeting Maker Client (User) Online Help

• HTML Calendar Online Help

DOCUMENTATION CONVENTIONS

This book uses the following documentation conventions:

Table 1: Documentation Conventions

Convention Description

Italicized Text Indicates a document title.

Bolded Text Indicates a field that requires user entry or an on-screen 
button. Also used in some headings and for special 
emphasis within body copy.

Fixed Width Font Indicates a file name, file path, code syntax or text 
string, or text a user must enter.

> Indicates a series of selections from cascading menus. 
For example: 
“From the top menu bar, choose File > New > Folder.”

<> Indicates a variable in a code or text string.
For example:
“At theprompt, type login <your user ID>.”

Note: Presents brief, additional information related to the 
current topic. A note can also be used as a reminder or 
for clarification.
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Important! Presents important, additional information related to 
the current topic. Important notes often inform users 
of settings/practices that could cause potential conflicts 
or yield unexpected results.

Warning! Indicates that certain settings/practices could result in 
data loss or application failure.

Tip: Presents helpful information related to the current 
topic, including alternative settings/practices that may 
simplify a complex process or yield better results.

Table 1: Documentation Conventions

Convention Description
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INTRODUCTION TO MEETING MAKER CALENDAR

Meeting Maker is a networked software application. The Meeting Maker 
Server stores users’ information centrally and relays needed information 
instantaneously between Calendar applications. 

When your Meeting Maker administrator has informed you how Meeting 
Maker Calendar will be distributed, you can install the application.

To use Meeting Maker Calendar after you install it, you must configure 
your server information so that Meeting Maker Calendar can find the 
Meeting Maker Server. You can then sign in to your account.

Meeting Maker is a group scheduling tool that makes it easy to:

• View Groups - View the availability and schedules of teams or 
groups of people from a single window.

• AutoPick Meeting Times - Automatically select the next 
timeslot when all attendees are available.

• Access Proxies - View coworker calendars in a side-by-side view 
with your own.

• Send and Receive Meeting Invitations in Real-time - Sched-
ule meetings in real-time - you request a meeting and the attendees 
are notified immediately.

• Schedule Recurring Meetings - Schedule customized recurring 
meetings - daily, weekly, bi-weekly, monthly, etc.

• Schedule Resources - Reserve conference rooms, A/V equip-
ment or other shared resources for your meeting.

• Share your Availability - Share your free and busy time with oth-
ers, vastly simplifying the group scheduling process.

• iCalendar Support - Send meeting invitations to people and cal-
endars outside of your organization using iCalendar.

• Integrate with Email - Provides the ability to contact attendees 
and send them attachments using your own email client.

• Simplify Scheduling - Eliminates the complex hassle of schedul-
ing meetings - no more juggling other people’s schedules, tele-
phone tag or email delays and subsequent rescheduling.

Some Meeting Maker personal calendaring features:

• Calendar Navigator - Quickly and easily select a date to view
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• Customized Views - Customize your calendar with colors and 
labels, various layouts, and numerous viewing options

• Direct Event Editing -  Edit your activities and meetings directly 
in the daily view

• Ease-of-Use - Intuitive GUI and functionality makes it easy to 
learn

• E-mail Reduction - Doesn't contribute to e-mail “inbox over-
load” when scheduling meetings because you're doing it straight in 
the Meeting Maker environment

• European Date/Time Formats - View dates and times within 
your calendar using the standard European formats

• Event Calendar Integration - Integrate the WebEvent View 
event calendaring solution with Meeting Maker to add published 
events directly into your personal calendar. 

• Event Creation - Create activities, banners (i.e. vacation, birth-
days, etc.), and to- do items for yourself.

• Font Customization - Adjust the font type and size based on 
your preference in the main calendar view.

• Multiple Calendar Views - View your calendar in day, week, 
month or text views.

• Pencil-in Events - Proposed meetings automatically populate 
your calendar where they can be directly accepted or declined.

• Printable Formats - Print your calendar out using common 
printout forms.

• Private Events - Mark events private so they can't be seen by oth-
ers.

• Recurring Banners - Set standard banners to display on a daily, 
weekly or monthly basis.

• Time Zone Support - Adjusts automatically to any of the 319 
time zones around the world.

MEETING MAKER CALENDAR REQUIREMENTS

Before you install Meeting Maker Calendar on your machine, make sure 
that your computer meets the Meeting Maker system requirements and 
that it is connected to your network.

Meeting Maker Calendar requires the following hardware and software for 
a minimum installation.
© Copyright PeopleCube, 2009. Last Modified: 3/23/09
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You can install Meeting Maker Calendar on Windows or Macintosh. The 
installation process differs depending on your operating system and 
whether you have a previous version of Meeting Maker on your machine. 

Before you install Meeting Maker Calendar, perform these tasks:

• Verify that your computer meets the installation requirements

• Connect the computer to your Meeting Maker network.

• Make sure that you have the following information ready so that 
you can sign in after you install. 

Tip: If your administrator has not filled in this information for 
you in the table below, you can print the page with the 
table, fill it in, and keep it for future reference

Table 1: Meeting Maker Requirements

Windows Requirements Macintosh Requirements

Operating System:
Windows 98, Windows NT 4.0, 
Windows 2000

Operating System:
OS X (v10.4 or higher)

Disk: 15 MB free disk space Disk: 15 MB free disk space

Network Protocol: TCP/IP or SSL Network Protocol: TCP/IP or SSL
© Copyright PeopleCube, 2009. Last Modified: 3/23/09 Page 3
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Note: You do not need this information to install Meeting 
Maker, but you need it to sign in for the first time. After 
the first time you sign in, you only need your sign-in name 
and password. Your Meeting Maker administrator may 
have created a custom installer to pre-configure some of 
this information for you. If so, you may not need all of the 
above information.

Table 2: Installation Information

Meeting Maker Sing-In 
name:

Meeting Maker 
Password:

Network Protocol (TCP 
or SSL)

Meeting Maker Server 
Name

DNS Names/IP 
Addresses of All Host 
Machines Running 
Meeting Maker Server:
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MICROSOFT WINDOWS INSTALLATION

1. Double-click the file Meeting Maker Calendar installer for Win-
dows. This file may be named setup.exe, mm_860_win.exe, or 
another name that your Administrator has given it: Ask your 
Meeting Maker administrator for the correct installer name. The 
Meeting Maker Setup dialog box appears.

2. Click Next. The Destination Location dialog box appears.

3. Select the desired location, and click Next. 

4. If a previous version of Meeting Maker exists on your computer, 
the Local Data Options dialog box appears. Select from these 
options:

• Move local Meeting Maker database - Creates local data 
backup

• Delete local Meeting Maker data - Deletes local data

• Do not move or delete Meeting Maker local data - Over-
writes local data with current Meeting Maker server data at 
sign in.

5. Select the readme and auto-launch settings, and click Finish.

6. Depending on the auto-launch settings, Meeting Maker Calendar 
may launch, or it may display the readme file or the Getting 
Started Guide. 

Installation is complete.

APPLE MACINTOSH INSTALLATION

1. Double-click the file Meeting Maker Calendar installer for Mac 
OS X. This file may be named LaunchInstaller or another name 
that your Administrator has given it: Ask your Meeting Maker 
administrator for the correct installer name. The Meeting Maker 
Setup dialog box appears.

2. Select the desired location, and click Next. The Choose Alias 
Folder window appears.

3. If a previous version of Meeting Maker exists on your computer, 
the Local Data Options dialog box appears. Select from these 
options:
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• Move local Meeting Maker database - Creates local data 
backup

• Delete local Meeting Maker data - Deletes local data

• Do not move or delete Meeting Maker local data - Over-
writes local data with current Meeting Maker server data at 
sign in.

4. Select the Calendar alias location, and click Install. Meeting Maker 
installs and creates the desired alias. The Install Complete window 
appears.

5. Select the desired readme and auto-launch settings, and click 
Done.

6. Select the readme and auto-launch settings, and click Finish.

7. Depending on the auto-launch settings, Meeting Maker may 
launch, create a desktop alias, display the readme file, or the Get-
ting Started Guide. 

Installation is complete.
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START MEETING MAKER CALENDAR

You can launch Meeting Maker Calendar on Windows or Macintosh. You 
can also configure Meeting Maker to launch on startup.

Launching Meeting Maker Calendar on Windows

1. From the Windows Start menu, select Programs > Meeting Maker 
> Meeting Maker.

The Welcome to Meeting Maker dialog box appears.

Launching at Startup on Windows

To configure Meeting Maker to launch at startup, create a Meeting Maker 
shortcut in the startup folder.

1. In the Meeting Maker installation folder, create a shortcut to 
Meeting Maker Calendar.

2. Drag the shortcut into the Start > Programs > Startup menu.

Meeting Maker will launch automatically when you start or restart your 
computer.

Tip: The Meeting Maker Calendar application is mm.exe and is 
located in: C:\Program Files\meetingmaker\mm.exe

Launching Meeting Maker Calendar on Mac OS X

1. Double-click the Meeting Maker Calendar icon.

The Welcome to Meeting Maker dialog box appears. 

Tip: If you did not create an alias during install, the default 
Meeting Maker icon is located in 
\Applications\meetingmaker\Meeting Maker 

Calendar.

Launching at Startup on Mac OS X

To configure Meeting Maker to launch at startup add a Meeting Maker 
Calendar to your system preference login list.

1. Click the Login icon in the OS X System Preferences window.

The Login window appears.

2. Click Add.
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The Open window appears.

3. Navigate Meeting Maker Calendar installation folder, and click 
Open.

Meeting Maker Calendar appears in the Login Items list of the 
Login window.

4. Close the Login window.

Meeting Maker will launch automatically when you start or restart 
your computer.

Tip: The Meeting Maker Calendar application is Meeting 
Maker Calendar and is located in: \Applications\meet-
ingmaker\Meeting Maker Calendar

CONFIGURE MEETING MAKER CALENDAR

After installation, you must establish communication between Meeting 
Maker Calendar and the Meeting Maker Calendar Server before you can 
sign in for the first time. 

Get the following information from your Meeting Maker administrator:

• Network protocol to use (SSL or TCP)

• Meeting Maker server DNS name or IP address 

• Meeting Maker server for sign-in

To configure Meeting Maker Calendar:

1. Launch Meeting Maker Calendar. The Welcome screen appears.

2. Click Select. The Select Server dialog box appears.

3. Select the network protocol (TCP or SSL) used by your Meeting 
Maker environment and click Configure. The Host List window 
appears.

4. Enter the server IP address or DNS name, and click OK. The 
server names appear in the Select Server pane of the Select Server 
dialog box.

Tip: To enable communication with multiple servers, enter 
each server IP address or DNS name, separated by a 
comma.

5. Highlight the Calendar Server, and click Select. Meeting Maker 
displays the selected Calendar Server in the Welcome to Meeting 
Maker window. 

6. Configuration is complete. You can now sign in to Meeting Maker.
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Sign in to Meeting Maker after you configure Meeting Maker Calendar 
with the appropriate settings.

1. Launch Meeting Maker. 

The Welcome screen appears.

2. Type your sign in name and password (case sensitive). If you don't 
know your sign in name or password, see your Meeting Maker 
administrator.

3. Click Sign In.

4. You are ready to use Meeting Maker.

WORK OFFLINE (OPTIONAL)

At the Sign In window, you can click Work Offline rather than Sign In to 
use Meeting Maker with local data. Your Calendar application will not be 
connected to the Calendar Server to access any real-time functionality. 
The next time you sign into the Calendar Server, any changes you made 
will be transmitted to the Meeting Maker Calendar Server, including 
notifying guests of meeting proposals.

Things to remember about working offline:

• Sign in to Meeting Maker server once before you can work offline.

• Your calendar is not connected to the Meeting Maker server. 

• Real-time or networked functions are disabled, such as viewing 
busy time, or sending and receiving proposals.

• Changes you make while offline will be synchronized to the Cal-
endar Server the next time you sign in.
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Calendar View

Proposals Window
Working With Meeting Maker 
Calendar

Once you have installed and configured Meeting Maker, you can sign in 
and begin to work with your calendar. You can control the Meeting Maker 
calendar view, propose meetings, schedule activities or banners, and 
perform other tasks. 

You can find advanced information in Meeting Maker’s online help 
system.

MEETING MAKER CALENDAR INTERFACE

When you sign in to Meeting Maker Calendar, the Main Window and the 
Proposals Window appear. The Main Window, Meeting Maker’s primary 
work area, shows the Daily View with one week displayed by default.
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The Main Window contains two basic elements, the calendar view and the 
task bar.

The calendar view can display your calendar in a number of different 
ways, including:

• The Daily View with one week displayed

• The Daily View with one day displayed

• The Monthly View

• The Text View

• The Group View

Daily View

The day and date for each displayed day appear at the top of the Daily 
View. Just below is the banner area, where any banners you create appear.

The main portion of the Daily View displays activities you schedule, and 
meetings you schedule or accept. An hour ruler appears on the left side of 
the Daily View, and a blue bar appears on the current day to mark the 
time.

Note:  For more information on banners, activities, or meetings, 
see the section below called, “Beginning Work with Meet-
ing Maker”, or see the Meeting Maker online help system.

The Meeting Maker Daily View first appears displaying its default setting, 
a five-day work week.

Ba
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Task Bar

The task bar appears at the left side of your Main Window. It contains 
links allowing you to create meetings, activities, or banners, change your 
calendar view, and perform other common tasks.

PROPOSE A MEETING

Meeting Maker Calendar allows you to propose a meeting in any of a 
number of ways. Three of the most common are:

• Click Create Activity/Meeting on the Task Bar

• Select New Activity/Meeting from the File menu

• Drag in your Daily View to create an activity, then click Invite 
Guests to turn the activity into a meeting 

To propose a meeting from the Task Bar:

1. In the Task Bar, click Create Activity/Meeting.

The Activity window opens. 

2. Enter a title for the meeting, and an agenda if desired.

3. Click the Guests tab. The Guests tab opens. The busy time grid 
displays the meeting as a blue rectangle.

4. Click Edit List to add guests. 

The Add Guests to Meeting dialog box appears. 

Tip:  The left pane displays available users, resources, locations, 
groups, and contacts. The right pane displays current 
meeting guests. A dropdown menu above the left pane 
allows you to filter the available guest list for quicker guest 
selection.

5. In the left pane, select the guests you want to invite to the meet-
ing. The guests appear highlighted. 

Tip:  You can invite resources and locations as well as human 
guests, booking them for the meeting. You can select mul-
tiple guests at once using system standard multi-select 
methods.

6. Click Required, Optional, CC, or BCC, depending on the 
desired guest type. The guests appear in the right pane with icons 
indicating guest type and availability.

Tip:  You can click Get Info to view information about a guest, 
or Search to find a guest.
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7. When you are done adding guests, click OK. The Add Guests to 
Meeting dialog box closes. The guests you added appear in the 
busy time grid.

Tip:  Each guest's row in the busy time grid displays the guest’s 
busy time in red, free work hours in white, and time out-
side work hours in blue. The Required row shows the 
combined free and busy time of all required guests.

8. If desired, drag or resize the blue meeting rectangle in the busy 
time grid to a time when all your guests are free.

9. Click Create Meeting. Meeting Maker sends the meeting invitation 
to your guests and places the meeting in your calendar.

Note:  If any of your required guests are not free at the time of 
the meeting, a message appears informing you and asking 
if you want to continue. If a requested resource or location 
is not available at the time of the meeting, Meeting Maker 
may not allow you to send the meeting until you resched-
ule the meeting or remove the resource or location from 
the guest list.
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ICONS AND SYMBOLS

Required guest - available Required guest - unavailable

Optional guest - available Optional guest - unavailable

Required resource - available CC guest

Optional resources - available BCC guest

Guest, location or resource 
availability unknown.

Group

Required location - available Required location - unavailable

Optional location - available Optional location - unavailable

At least one required guest has 
declined your proposal.

Proposal is outside guest’s work 
hours

New incoming proposal. All required guests have 
accepted your proposal

Rescheduled meeting/proposal Changed meeting proposal

Meeting/Proposal cancelled No guests have responded to 
the proposal

Accepted meeting/to do Declined meeting/to do

Flexible event Inflexible event
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CREATE A BANNER

You can create banners to mark single or multi-day events in your 
calendar that have no associated time. You can use banners to mark 
vacation time, travel time, project schedules, birthdays, and other 
important dates or periods. 

You can create a banner in any one of three ways:

• Click and drag in the banner area of the Daily View

• Click Create Banner in the Task Bar

• Select New Banner from the File menu

The simplest way to create a banner is to drag in the banner area at the top 
of your Daily View.

To create a banner:

1. In the Daily View, drag in the banner area on the desired banner 
start date. A shaded rectangle appears.

2. Drag the rectangle until it spans the days you want to mark with 
your banner. The banner appears in the banner area with a blink-
ing cursor.

3. Type a title for the banner and press Enter (Return on a Macin-
tosh). The banner appears with the title you entered. 

ACCESS ONLINE HELP

You can access the Meeting Maker Calendar online help system for 
further and more in-depth information on using Meeting Maker.

To access Meeting Maker online help:

1. From the Help menu, select Contents.

2. Meeting Maker displays the Calendar online help.

Private activity/banner Recurring event

Agenda included Meeting/to do guest

Guest comment included
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KEYBOARD SHORTCUTS

Meeting Maker Calendar Shortcuts

File Menu Windows Macintosh

New Main Window
New Activity/Meeting
New Banner
Close Main Window
Print Schedule
Print Events
Sign Out
Exit

Ctrl+Shift+N
Ctrl+N
Ctrl+B
Ctrl+W
Ctrl+P
Ctrl+Shift+P
Ctrl+L
Ctrl+Q

Cmd+Shift+N
Cmd+N
Cmd+B
Cmd+W
Cmd+P
Cmd+Shift+P
Cmd+L
Cmd+Q

Edit Menu Windows Macintosh

Accept Proposal
Decline Proposal
Cancel Event
Preferences
User Info
Display Time Zone
View Options

Ctrl+Shift+Y
Ctrl+Shift+X
Backspace
Ctrl+Shift+F
Ctrl+U
Ctrl+Shift+Z
Ctrl+Shift+V

Cmd+Shift+Y
Cmd+Shift+X
Delete
Cmd+,
Cmd+U
Cmd+Shift+Z
Cmd+Shift+V

Proxy Menu Windows Macintosh

Edit Favorite Proxies
Share Calendar

Ctrl+Shift+L
Ctrl+R

Cmd+Shift+L
Cmd+R

View Menu Windows Macintosh

One Day
One Week
Monthly
Text
Group View
Go to Today

Ctrl+Shift+D
Ctrl+Shift+W
Ctrl+Shift+M
Ctrl+Shift+T
Ctrl+Shift+G
Ctrl+T

Cmd+Shift+D
Cmd+Shift+W
Cmd+shift+M
Cmd+Shift+T
Cmd+Shift+G
Cmd+T

Window Menu Windows Macintosh

Current Calendar View
Proposals
Reminders
Address Book
To Do List

Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5

Cmd+1
Cmd+2
Cmd+3
Cmd+4
Cmd+5
© Copyright PeopleCube, 2009. Last Modified: 3/23/09



Meeting Maker Getting Started Guide:
Meeting Maker HTML Calendar  
Meeting Maker HTML Calendar

This chapter contains introductory information about Meeting Maker 
HTML Calendar. It also contains instructions on how to access more 
detailed information from the Meeting Maker HTML Calendar online 
help system.

OVERVIEW

If your environment uses HTML Calendar, you can sign in to your 
Meeting Maker account from any web browser without installing any 
Meeting Maker software.

You can find advanced information in HTML Calendar's online help 
system.

ACCESS THE MEETING MAKER HTML CALENDAR

You can use any web browser to access HTML Calendar. 

If your environment uses HTML Calendar, your Meeting Maker 
administrator can provide you with the URL to access HTML Calendar. 
Entering the URL in your web browser displays the HTML Calendar sign 
in screen. 

To sign in to HTML Calendar:

1. Make sure you have the URL to access the Meeting Maker HTML 
Calendar. If you do not know the URL to access the Meeting 
Maker HTML Calendar, contact your Meeting Maker administra-
tor.

2. Launch your Internet browser and enter the URL.

The Welcome page appears.

3. In the Sign In window, enter your Sign In Name and Password.

Remember that Meeting Maker passwords are case sensitive.

If you do not have a Sign In Name or Password, contact your 
Meeting Maker administrator.

4. From the Server dropdown menu, select the server on which your 
account resides. If you do not know your server, contact your 
Meeting Maker administrator. If only one server appears in the 
menu, use that server.

5. Click Sign In.

Your web browser displays your Calendar.
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HTML Calendar displays your schedule in your home time zone, 
or Work Hour Time Zone. If you are traveling outside of your 
usual time zone, your schedule does not appear in local time, and 
your reminders do not come in at local time.

You are now signed in and can begin working with HTML Calen-
dar.

WORK WITH HTML CALENDAR

When you sign in, the HTML Calendar displays the main window, which 
consists of three elements:

• The Task Bar, at the left of the main window, which contains 
links allowing you to create meetings, banners, or activities, or to 
perform other advanced Meeting Maker tasks.

• The Calendar View, which displays your schedule, and can be 
viewed in a number of different ways. The Calendar View opens 
displaying the Daily View by default.

• The Proposals Panel, below the calendar view, which shows a 
list of proposed meetings received from other users, a list of meet-
ing proposals you have sent to other users, and a list of proposals 
you have declined.

For more detail on these tasks, or for other instructions, see “Access 
HTML Calendar Online Help”, below.

ACCESS HTML CALENDAR ONLINE HELP

You can access the HTML Calendar online help system for further 
information on calendar procedures, calendar preferences, display 
controls, and other advanced tasks.

To access HTML Calendar online help:

1. In the task bar, click the Help button.

Meeting Maker displays the HTML Calendar online help.
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Calendar

UNINSTALL MEETING MAKER CALENDAR

Do not uninstall Meeting Maker Calendar by deleting files manually. The 
Admin, Server, and Calendar applications share files that may be removed 
when you uninstall. If the Admin, Server, or Calendar applications reside 
on the same machine and you uninstall one of the programs, the 
remaining programs will no longer work properly.

Uninstalling on Windows

To uninstall Meeting Maker Calendar on Windows:

1. Close open Meeting Maker applications.

Open applications may cause incomplete uninstall.

2. From the Windows Start menu, select Programs > Meeting Maker 
> Meeting Maker Uninstall. 

The Confirm Uninstall dialog box appears.

3. Click OK.

Meeting Maker completes the Calendar uninstall, and the Mainte-
nance Complete dialog box appears.

4. Click Finish.

Uninstall is complete.

Uninstalling on Macintosh

Do not uninstall Meeting Maker by deleting files manually.

To uninstall Meeting Maker Calendar on Mac OS X:

1. Close open Meeting Maker applications. Open applications may 
cause incomplete uninstall.

2. Double-click the Uninstall Calendar file. 

The default location is \Applications\meetingmaker\Unin-
stall

The Uninstall window appears.

3. Click Next.
The Uninstall Options window appears.

4. Select the desired uninstall option and click Next.
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Note:  If you choose to uninstall specific features, you can unin-
stall the Calendar application, online help, exporters, or 
print layouts. After making your selections, click Uninstall.

5. Click Done.

Files and Folders Remaining After Uninstall

The files and folders that are not removed during uninstall contain 
important Meeting Maker data. Do not delete these files and folders if you 
plan to reinstall Meeting Maker on the same computer. 

This table lists the folder and files that are not removed during uninstall.

Table 3: Files Not Removed by Uninstall

Folder/File Name Location

$<user name> 
folder

C:\Program Files\meetingmaker\mmclnt32

mmusrprf.mdb C:\Program Files\meetingmaker\mmclnt32

mmdata.mdb C:\Program 
Files\meetingmaker\mmclnt32\<user 
name>

mmcond.ini C:\Palm
© Copyright PeopleCube, 2009. Last Modified: 3/23/09


	Getting Started Guide
	Copyright & Legal
	About This Guide
	Audience
	Related Documentation
	Documentation Conventions

	Contents
	Before You Install Meeting Maker
	Introduction to Meeting Maker Calendar
	Meeting Maker Calendar Requirements
	Installation Preparations

	Installing Meeting Maker Calendar
	Microsoft Windows Installation
	Apple Macintosh Installation

	After You Install Meeting Maker Calendar
	Start Meeting Maker Calendar
	Configure Meeting Maker Calendar
	Sign In to Meeting Maker Calendar
	Work Offline (Optional)

	Working With Meeting Maker Calendar
	Meeting Maker Calendar Interface
	Propose a Meeting
	Icons and Symbols
	Create a Banner
	Access Online Help
	Keyboard Shortcuts

	Meeting Maker HTML Calendar
	Overview
	Access the Meeting Maker HTML Calendar
	Work with HTML Calendar
	Access HTML Calendar Online Help

	Uninstalling Meeting Maker Calendar
	Uninstall Meeting Maker Calendar


